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概 要

シリコンカーバイド (SiC)はすぐれた物性的特徴から次世代半導体材料として
注目されている．SiC以外の半導体材料ウェーハーは液相からの成長によって低コ
ストで製造されているが，SiCではいまだ確立していない．これは，SiC相を液相
と同じ組成から直接に凝固で得られないからである．そこで新しく金子らによっ
て，SiCを液相からエピタキシャル成長させる方法が開発された．その構成はよく
知られた”溶媒移動 (Traveling Solvent) 法”と似ているが，温度勾配が存在しな
く，溶媒移動の駆動力は SiCの代表的な多形である 3C,4H,6H-SiCの安定性の差で
ある．この研究では実験では不明な点である 3C,4H,6H-SiCの有限温度の自由エネ
ルギーを第一原理計算で求めた．
計算手法は次のとおりである．

1. 　第一原理計算ソフトは VASP(Vienna Ab-initio Simulation Package)を用い
て結晶の静止エネルギー (振動していないときの格子の持つエネルギー)およ
び，原子を 1つ動かしたときに各々の原子にかかる力を求める．

2. 　振動の自由エネルギーの求め方は擬調和振動子近似である phonon-DOS法を
用いた．

3. 　 phonon-DOS法での計算に熱膨張を考慮した．特に，4H,6H-SiCの六方晶の
場合 a,c軸を独立して考えなければならない．

計算結果は，第一原理計算ソフトVASPで求めた基底状態の安定性は3C<4H<6H

となっており，他の研究者が求めた第一原理計算と同等な結果が得られている．振
動の効果を考慮した場合，低温では 4Hが最安定であるという新たな知見を得た．
高温では 6H-SiCが最も安定であり，中間温度域では 3C<4H<6Hとなっている．
これは，温度に対する結晶多形の発生確率の結果と一致しており，結晶成長させ
るときの実験結果とも一致している．
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第1章 序論

1.1 研究の背景
シリコンカーバイド (SiC)はすぐれた物性的特徴から次世代半導体材料として注
目されている．SiC以外の半導体材料ウェーハーは液相からの成長によって低コス
トで製造されているが，SiCではいまだ確立していない．これは，SiC相を液相と
同じ組成から直接に凝固で得られないからである．そこで我々は，SiCを液相から
エピタキシャル成長させる方法を紹介する．その構成でよく知られれた”溶媒移
動 (Traveling Solvent) 法”と似ているが，温度勾配が存在しない．溶媒移動の駆
動力は SiCの代表的な多形である 3C,4H,6H-SiCの化学ポテンシャルの差である．
この研究では 3C,4H,6H-SiCの有限温度の自由エネルギーを第一原理計算で求める
事によって，SiCの結晶成長を制御する必要な知見を得ることを目的とする．

1.2 SiCの結晶多形 (ポリタイプ)

SiCの IV族原子同士の結合であるが，SiがCより電気陰性度が大きいことによ
り約 18のイオン性を持つ共有結合型の結晶で，結晶学的には，同一の組成で c軸
方向に対して多用な積層構造をとることができ，100種類以上の結晶多形 (ポリタ
イプ)が存在する．多くの結晶多形のなかでも発生確率が高く，応用上重要となる
3C-, 4H-, 6H-SiC( Ramsdellの表記法 ) の結晶構造を図 1.1に示す．これら結晶多
形の表記方法は，積層方向の単位格子に含まれる Si-C単位層の数と，結晶系の頭
文字 ( C : 立方晶，H : 六方晶 )を組み合わせて表されている．

SiCの全ての結晶多形において，SiとCの比は 1対 1で，1/4のC(1/4の Si)を
四つの頂点に配し，中央に Si(C)配した正四面体を基本最小構造とする．この正四
面体を頂点が重なるように配置すると，a, b, cの 3種類の配置が考えれる．また，
正四面体は面内で 180°回転した配置を取ることができ，このときの配置を a*, b*,

c* とする．この 3種類の配置にどの向きの正四面体を重ねていくかによって SiC

の結晶多形が形成される．
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図 1.1: 代表的な SiC結晶多形の結晶構造の (11-20面)への投影図. ●がシリコン
(Si), ○がカーボン (C)である．中心に 1つの Si, 1/4Cを 4つの頂点に配した正四
面体を SiCの最小単位として，この正四面体の積層周期の違いが SiCにおける結
晶多形である．
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1.3 ワイドギャップ半導体
表 1.1に代表的な SiCポリタイプの主な物理的性質を示す．SiCでは Si-C原子間

距離が 0.189nmと短く，結合エネルギーが高いことに起因して，禁制帯幅，絶縁
破壊電界が大きい値を示す．数多くの SiCポリタイプの中で，現在最もデバイス応
用に適していると考えられているのは 4H-SiCである．この理由として，禁制帯幅
や絶縁破壊電界が大きいこと，良質の単結晶ウェーハーが入手でき，その上に高
品質エピタキシャル成長層を形成できることなどが挙げられる．表 1.2に 4H-SiC,

表 1.1: 代表的な SiCポリタイプの主な物理的性質 [1]．
3C-SiC 4H-SiC 6H-SiC

積層構造 abc abcb abcacb

禁制帯幅 (eV) 2.23 3.26 3.02

絶縁破壊電界 (MV/cm) 1.5 2.8 3

飽和ドリフト速度 (cm/s) 2.7× 107 2.2× 107 1.9× 107

熱伝導率 (W/cmK) 4.9 4.9 4.9

Si, GaAs, GaN, ダイヤモンドの主な物性値とそれを基に計算した Johnsonの性能
指標 (高周波デバイス応用)および Baligaの性能指標 (パワーデバイス応用) を示
す (それぞれ Siの値で規格化している)．同表には，デバイスを作製するときに重
要なとなる技術的側面の比較も示している．4H-SiCで特筆すべき物性は，絶縁破
壊電界が SiやGaAs の約 10倍，電子の飽和ドリフト速度が約 2倍，熱伝導率が Si

の約 3倍と高いことである．
SiCは，広禁制帯幅半導体の中では例外的に p,n両伝導型の広範囲価電子制御が
容易であること，Siと同様に熱酸化により良質の絶縁膜 (SiO2)が形成できること，
および導電性あるいは絶縁性ウェーハーが市販されていることが特長である．SiC

は広い禁制帯幅を有し，熱的に安定な材料であることから，当初は高温動作デバ
イス用材料として研究開発が進められた．通常，Siを用いたデバイスでは，最高
動作温度が 150～200℃に制御されるが，SiCでは 500℃の高温の温度でもデバイ
ス動作が可能である．

1.4 SiCの温度に対する発生確率とエネルギー計算値
比較

図 1.2(b)は複数の研究者が第一原理計算で計算した SiC結晶多形に対する全
エネルギー値の比較したものである．この図では SiCの結晶成長によく現われる
3C,4H,6H-SiCのエネルギー差はほとんどない．図 1.2(a)は各種の実験で得られた
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図 1.2: (a) 昇華法における SiC結晶多形の発生確率の温度の依存性 [2]．(b) 複数
の研究者が第一原理計算で計算した SiC結晶多形に対する全エネルギー値の比較．
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表 1.2: 4H-SiC, Si, GaAs, GaN, ダイヤモンドの主な物性値，性能指標，および技
術の現状 (○:容易あるいは入手可能，△:可能だが限定される，×:困難)[1]．

4H-SiC Si GaAs GaN ダイヤモンド
禁制帯幅 (eV) 3.26 1.12 1.42 3.42 5.47
絶縁破壊電界 (MV/cm) 2.8 0.3 0.4 3 8
飽和ドリフト速度 (cm/s) 2.2× 107 1.0× 107 1.0× 107 2.4× 107 2.5× 107

熱伝導率 (W/cmK) 4.9 1.5 0.46 1.3 2.0
Johnsonの性能指標 420 1 1.8 580 4400
Baligaの性能指標　 470 1 15 680 13000
p型価電子制御 ○ ○ ○ △ △
n型価電子制御 ○ ○ ○ ○ ×

温度に対する SiC結晶多形の発生確率で，低温では 3Cが，中間温度では 4H，高
温では 6Hが発生しやすい．つまり，温度によって発生する SiC結晶多形の確率が
変わってくることが実験的には示されている．このような矛盾を解明するため，第
一原理計算でもとめた絶対零度のエネルギーに振動効果を取り入れた計算によっ
て有限温度のエネルギー差を精密に計算することを本研究の目的とした．

1.5 SiCの相安定性に関する実験結果
京都大学の藤原によってまとめられた SiCの熱力学データを採録する．

1.5.1 結晶構造と相変態

• Ref.1によれば β が cubicで，α が hexagonalである．包晶温度以下の全温
度範囲で β が安定相としている．

• Ref.2によれば，Ramsdell notationで 6H, 15R, 4H と表記される α の多形
が存在することが示唆される．

• また，Ref.2では 2000℃以上で α が安定とする論文 (Ref.3)があることを紹
介している．

• しかし，Ref.4は βのみを安定相とし，2000℃以上での β から α への変態
に否定的である．

1.5.2 Si＋C系状態図

• Ref.1,2の状態図は図 1.3のとおりである．
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• Ref.5では高温で β から α への変態する状態図を採用している．また，低圧
かでの状態図が収録されている．図 1.4のとおりでる．

図 1.3: Phase diagram of Si+C binary system[1]．

1.5.3 液体シリコン中へのカーボンの溶解度

• Ref.6～16に溶解度の実測値．データのプロッドは図 1.5のとおりである．

• Ref.8(Ref.6,7が引用)には直接溶解度につながるデータの記載は見当たらない．

• Ref.13,15は未入手で，Ref.16表から転載である．

• ASMの状態図 (Ref.1,2でRef.9に準拠)を支持するデータはほとんどない．

• Ref.5はRef.9を採用している．
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図 1.4: Phase diagram of Si+C binary system(ref. [5]: Fromm and Gebhardt)．

図 1.5: Solubility of carbon in liquid silicon．
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1.5.4 α相および β相の定圧比熱

• 純粋な SiCに対するRef.4の熱力学データは図 1.6のとおりである．

• β とα の自由エネルギーの差はごくわずかである．標準生成エンタルピーの
精度と比べて有意差が明らかといえる．

• Ref.4によれば，標準生成エンタルピーはそれぞれ

4fH(α-SiC,298.15K)=-71.546±6.3kJ·mol−1

4fH(β-SiC,298.15K)=-73.220±6.3kJ·mol−1

図 1.6: Heat capacity and Gibbs energy of SiC(ref.4:JANAF Table 4th)．
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1.6 準安定溶媒エピタキシー法

1.6.1 準安定溶媒エピタキシー法の装置と試料

図 1.7 に新しいプロセスの試料周辺の構成を模式的に示した．TaCるつぼに SiC

と Siのサンドイッチ構造を保持している．これを高真空雰囲気下でタングステン
ヒーターによって均質に加熱する．サンドイッチ構造は，SiCと Siの板で構成され
ており，その順序は図 1.7の通りである．SiCの局所的な原子配置は閃亜鉛鉱 (zink

blende)構造と同じ，SiのまわりにCが 4配位し，逆にCは Siに囲まれている．し
かし，その積層順序は多様で，エネルギーの近い結晶多形が存在する．中でも，3

周期で立方晶 (cubic) をなす 3C，および 4周期で六方晶 (hexagonal)をなす 4H構
造が安定な相としてよく現われる．図 1.7に示した準安定溶媒エピタキシー法の構
成では，多結晶 3C SiC の板は原料を供給するフィードとなり，単結晶の 4H SiC

がエピタキシャル成長の基板つまりシードとなる．るつぼを SiCエピタキシャル
成長温度である 1800℃まで加熱すると，Siは融けて炭素を運ぶ溶媒として働く．
溶媒の厚みは極めて薄く，数十から数百μmである．成長プロセスにおいては高
温で数分間保持した後，冷やされる．

図 1.7: 準安定溶媒エピタキシー法の試料周辺の構造図．

図 1.8 に成長温度で 10分間保持した試料の断面の走査顕微鏡像を示した．4H

SiCの基板上に新たに 4H SiC が約 25μmエピタキシャル成長しているのが観測
される．基板の 4H SiC は窒素ドープされているため，元々の基板と新たに成長し
た層は明確に区別される．多結晶の 3C SiC は昇温前はより緻密であるが，溶媒 Si

と接すると界面から優先的に溶解し，加熱処理後にはまばらになっている．エピ
タキシャル成長中は，液体 Si の領域がフィードからシードへ炭素を供給する溶媒
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として働く，波長分散X線 (WDX) による炭素濃度プロファイルが同じ写真に示
されている．Si溶解中の炭素濃度はほぼ零であるが，溶媒が極めて薄いため結晶
成長に十分な炭素が供給される．多結晶 3C SiCシードと単結晶 4H SiC基板とを
位置関係が逆になるようにしても，同じ 4H SiC のエピタキシャル成長が起こるた
め，意図しない温度勾配が坩堝内にあるとは考えられない．

図 1.8: 準安定溶媒エピタキシー法で得られた試料周辺の走査電子顕微鏡像と波長
分散X線 (WDX)による炭素濃度のプロファイル．

1.6.2 準安定溶媒エピタキシー法の原理

準安定溶媒エピタキシー法において 4H SiCが成長する駆動力を説明する．その
駆動力は，小学校の理科の実験でやったミョウバンの結晶成長と同じく，濃度勾
配である．そこでは，まず始めに温度を上げた水にミョウバンを溶解する．この
水溶液の温度を下げるとミョウバンは過飽和となり，うまく種を置けば単結晶と
して析出する．
準安定溶媒エピタキシー法の系は少し込み入っているので，よく似た装置構成
を持った図 1.9(a) の”溶媒移動 (traveling solvent)法” から見ていく．SiCのフィー
ドとシードで薄い Si層を挟んだサンドイッチ構造が，Si層に垂直に温度勾配を持
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図 1.9: 溶媒移動 (traveling solvent)法の原理を示す模式図．(a)が装置構成を，　
(b)が対応する状態図を示している．

つように上側から加熱される．フィードの界面温度が T + Δ T であるので，図
1.9(b) の状態図から分かる通り，Siに対する SiCの溶解度は X + ΔX％ である．
シードの界面での温度 T での溶解度限はX％である．溶解度はより高い濃度へ誇
張して書いている．この濃度勾配によって，過剰な SiCはフィードの界面から溶
解し，液体 Si溶媒を拡散し，シードの界面に析出する．このように，液体 Si層が
フィード側の下から上へと自動的に移動することから，溶媒移動法と呼ばれてい
る．このとき，溶媒をを移動させる駆動力は，温度勾配から得られる濃度勾配で
ある．新しいプロセスでは，しかし，結晶成長の間中，温度は空間的にも時間的
にも一定に保持される．同じ組成を持った材料が向かい合っているため，濃度勾
配を得ることは困難に思われる．そうすると溶媒層が上へ行くのか下へ行くのか，
あるいはむしろその場にとどまるのか確証がないように思えるかも知れない．し
かし，方向は以下に示すとおり決まっている．
これは図 1.10(a)に模式的に示した SiCのダブル状態図から明確に導かれる．ダ

ブル状態図は治金学においては Fe-C系のごとくなじみ深く [3]，準安定相を含ん
だ系においては一般に現われる．Si( l )→ Si( s ) + SiC( 3C )の準安定共晶温度
は，Si( l )→ Si( s ) + SiC( 4H ) の安定共晶温度よりも低い温度にある．対応す
る組成ー自由エネルギー図は図 1.10(b)に模式的に示した．それぞれの相の溶解度
限は，共存相の自由エネルギーの共通接線で得られる．温度Tにおいて，準安定
3C SiC の溶解度はC(3C)で，対応する液相線が図 1.10(b)の破線で示されている．
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もう一つの安定 4H SiCの固溶限はC(4H)で実線で示した液相線に対応している．
濃度勾配が，3Cと 4H SiCと間に挟んだ Si薄膜のサンドイッチ構造から得られる．
その模式的な濃度プロファイルを図 1.10(c)に示した．3C SiCの準安定溶解度か
ら濃度勾配によって，フィードから炭素が取り出される．おなじ温度勾配によっ
て，炭素は液体 Si中を拡散し，シードの界面へ持ち来らされる．そこで，炭素は
4H SiCに対して過飽和なため，析出する．

1.6.3 準安定溶媒エピタキシー法の特徴

このプロセスを”準安定溶媒エピタキシー (Metastable Solvent Epitaxy)”．と命
名した．このMSE法は SiCのエピタキシャル成長に対して魅了的な多くの特徴を
有している．溶媒移動法と共通する特徴は，(1)シードとフィードの組成が同なの
で安定した成長が得られる，(2)シードとフィードのサンドイッチ構造によってる
つぼが不必要である．(3)装置に移動部位がない．

MSEに独自の特徴の第一は，もちろん上で述べた駆動力である．第二は，結晶
成長中に空間的にも時間的にも温度勾配がないという点である．通常の凝固にお
いて，界面の不安定性や多結晶が現われる大きな原因のひとつは，いわゆる組成
的過冷却である．これは温度勾配と濃度勾配の制御の失敗によってもたらされる．
温度勾配がないため，濃度勾配だけで成長の動力学が制御されるので，エピタキ
シャル成長を自動的に安定化させることが可能となる．
第三のMSEに独自の特徴は液体 Si溶媒の薄さである．液相 Si溶媒中を炭素が
拡散する間，安定状態図から分かる通り炭素は過飽和であるため，溶媒は不安定
である．したがって，溶媒が厚くなると，4H SiC基板以外で核生成する機会が現
われる．溶媒は，核生成を抑えるために薄くなければならない．これが溶媒を薄
くする主な目的であるが，副次的な効果がいくつもある．

対流の抑制 　液相 Siの厚みは，通常の凝固プロセスの拡散層程度であるので，対
流はほとんど起こらない．

拡散量 　 Si-C系は Si中の炭素の溶解度限が非常に小さく，結晶成長に必要なだ
けの量の炭素を供給できないと信じられてきた．しかし，単純な計算から分
かる通り，拡散長を短くすれば，十分な炭素を供給でき，結晶成長が可能と
なる．

低い操作温度 　炭素の溶解度限は，拡散長を短くすれば，高い必要がない．した
がって，炭素の溶解度を十分に取るために必要な操作温度を上げるという通
常の戦略も必要なくなる．

液相 Siの蒸発抑制 　真空に晒す表面積を小さくできるため，低い操作温度とあ
いまって揮発性溶媒でも長時間操業が可能となる．
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図 1.10: 準安定溶媒エピタキシー法の原理を説明する模式的な (a)ダブル状態図，
(b)組成ー自由エネルギー図および (c)炭素濃度プロファイル．
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第2章 計算原理

この章では，quasi-harmonic近似法と phonon-DOS法について説明する．本研
究では，phonon-DOS法で振動の自由エネルギーを求めているが，比較するため
に同様な手法である quasi-harmonic近似法についても説明する．

2.1 SiCの構造の作成
MedeAというソフトウェアを使って結晶モデルを作成する．MedeAは，データ

ベースと第一原理計算の手法を 1つのプラットフォームで統合した，材料設計支
援のための統合ソフトウェアである．グラフィックスインターフェースおよび計算
プログラムは全てWindowsシステム上で稼働するので，構造の検索・構築・編集，
計算，解析までを 1つのプラットフォーム上で行うことができる．

2.2 quasi-harmonic近似法
Suttonらが開発した quasi-harmonic近似法は，二次モーメント近似をもちいて

フォノン状態密度を求め，そこから有限温度の自由エネルギーを算出する方法で
ある [4][5]．ここで，各温度での原子間距離は，自由エネルギーを最小にするよう
に決める．
Quasi-harmonic近似法では次のような手順で計算をおこなう．

1. 　原子間距離をあたえ，対象とする格子を生成する．

2. 　バネ定数 kを求め，振動数の二次のモーメント (二乗の平均)µ2を µ2 = k/m

から求める (mは原子質量)．

3. 　二次のフォノン状態密度 (ωについての状態密度)を楕円近似で描く．ここで
楕円の中心には 2で求めた µ2をもちいる．そして二次の状態密度から一次
の状態密度を生成する．

4. 　得られた一次の状態密度から，調和近似をもちいて自由エネルギーを計算
する．

以上の計算を，原子間距離を変えながらおこない，自由エネルギーを最小にする
原子間距離を求める．この詳しい計算原理について以下に述べる．
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2.2.1 調和近似による自由エネルギー計算

熱力学の公式によると，ある温度 T におけるフォノン 1つの自由エネルギー f

は f=-kBT lnZで示される．ここに調和近似を適用すると，振動数がωであるフォ
ノンの自由エネルギーは

　

f = kBT ln
[
2 sin h

(
h̄ω

2kBT

)]
(2.1)

となる．よって，系の全自由エネルギーは，フォノン状態密度 n(ω)をもちいて，
次式で示される．

　

F = Es + kBT
∫ ∞

0
n(ω)ln

[
2 sin h

(
h̄ω

2kBT

)]
dω (2.2)

ここで，Esは静止エネルギー (平衡原子位置に原子が止まっているときのエネル
ギー)を示す．原子間距離を決めるとEsは求まるので，フォノン状態密度が決ま
れば，式 2.2から系の自由エネルギーが求まる．

2.2.2 二次モーメント近似によるフォノン状態密度の導出

フォノン状態密度 n(ω)は図 2.1(b) で示したような複雑な形をしており，これを
厳密に計算するためには煩雑な計算が必要となる．そこで Sutton らはフォノン状
態密度を二次モーメント近似から求めた．二次モーメント近似とは二次曲線など
の簡単な図形で状態密度を近似する手法であり，その図形は二次モーメント µ2が
実際の状態密度の µ2と等しくなるように決める．以下に，二次モーメント近似に
よる状態密度の描き方を述べる．
二次のモーメント µ2は次式で与えられる．

　

µ2 =
∫ ∞

0
ω2 · n(ω)dω

=
∫ ∞

0
ω2 · g(ω2)dω2 (2.3)

ここで，g(ω2)は振動数の二乗についての状態密度 (二次の状態密度)を示す．実際
g(ω2)は図 2.1(a)で示されるような形状である．図 2.1(a)のように，系の二次モー
メント µ2を中心に持つ半楕円を描くと，この半楕円の二次モーメントも µ2にな
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る．よって，この半楕円は g(ω2)の近似形として採用できる．g(ω2)とn(ω)の間に
は式 2.4で示される関係が成り立つので，g(ω2)が楕円の式で与えられれば，n(ω)

は解析的に求まる．

　

n(ω) = 2ω · g(ω2) (2.4)

よって，n(ω)は g(ω2)から解析的に求められるので，半楕円をもちいて g(ω2)を
描けば，図 2.1(b)のような一次のフォノン状態密度が得られる．
この二次のモーメント近似を適用すると g(ω2)は楕円の式で次のように描ける．

　

g(ω2) =
6

πµ2
2

[
µ2

2 −
(
ω2 − µ2

)2] 1
2

(2.5)

ここで，係数は
∫ ∞
0 g(ω2)dω2 = 3を満たすように決めた (3は各原子の自由度を

示す)．また，µ2として µ2=k/mをもちいる (kはバネ定数)．このとき式 2.4から
n(ω)を次のようになる．

　

n(ω) =
12ω2

πµ2
2

(
2µ2 − ω2

) 1
2

(2.6)

ω = (2µ2)
1/2yと変数変換すると，

　
∫ ∞

0
n(ω)dω =

∫ ∞

0

12ω2

πµ2
2

(
2µ2 − ω2

) 1
2

dω =
48

π

∫ 1

0
y2(1 − y2)

1
2 dy (2.7)

となる．以上より，系の全自由エンルギーは次式のようになる．

　

F = Es +
48kBT

π

∫ 1

0
y2(1 − y2)

1
2 · ln

[
2 sin h

(
cy

2

)]
dy (2.8)

ただし，c = h̄(2µ2)
1/2/kBT 　である．
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図 2.1: (a)二次の状態密度　 (b)一次の状態密度．

2.2.3 原子間距離の計算

quasi-harmonic 近似法における平衡原子間距離の求め方を述べる．式 2.8から，
原子間距離があたえられれば自由エネルギーが決まる．そこで，ある温度で原子
間距離を変えながら自由エネルギー F を計算する場合を考える．原子間の距離を
基底状態の平行距離から広げていくと，式 2.8の右辺第一項である静止エネルギー
は上昇していく．また，原子間距離が広がるとバネ定数が小さくなる (軟らかくな
る)ので，振動数は小さく (振幅は大きく)なり，式 2.8の右辺第二項の振動項は減
少する．このように，原子間距離が広がるにつれ，静止エネルギーの項が増加し，
振動項が減少するので，ある原子間距離において自由エネルギーは最小値を取る
(図 2.2)．この原子間距離が，その温度の平衡原子間距離である．
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図 2.2: 平衡原子間距離の決定 (模式図)．

2.3 phonon-DOS法
今日の第一原理計算は振動の効果のない状態，すなわち絶対零度での計算となっ
ている．しかしながら，熱膨張率，比熱，電気伝導率などの諸物性は有限温度に
おいて振動の影響を受ける．そのため，有限温度での物性を計算により求めるこ
とは，振動の効果を取り入れて計算することが必要となる．また，今日の計算機
のめざましい発展により，振動の効果を取り入れて計算することが可能となって
いる．
計算の過程でフォノンの分散関係を求める．第一原理法によるフォノンの分散関
係の求めた方は大きく分けて 2種類ある．1つ目はスーパーセルを用いない linear

response method，もう 1つはスーパーセルを用いる direct methodである．本研
究では後者の direct methodを用いて計算する．

2.3.1 格子定数の計算のながれ

格子定数を求める計算のながれについて簡単に説明する．次のような手順をふむ．

1. 　第一原理計算ソフトは VASP(Vienna Ab-initio Simulation Package)を用い
て結晶の静止エネルギー (振動していないときの格子の持つエネルギー)およ
び，原子を 1つ動かしたときに各々の原子にかかる力を求める．
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2. 　動かした原子とかかった力より力の定数を求め，それより周波数ωと波数 k

の関係 (分散関係)を求める．

3. 　分散関係よりフォノンの状態密度を求める．

4. 　状態密度より振動の自由エネルギーを求め，それに静止エネルギーを足して
系全体の自由エネルギーを求める．

5. 　格子の長さを変化させて，1から 4を繰り返す．そして各温度で自由エネル
ギーを格子の長さについてプロットし，自由エネルギーが極小値をとるとき
の格子の長さをその温度における計算上の平衡な格子定数とする．

　以下さらに詳しく説明していく．

2.3.2 平面波基底擬ポテンシャル法

密度汎関数に基づく第一原理擬ポテンシャル法によるバンド計算VASP codeを
用いて計算を行う．この手法では，3次元周期境界条件を満たす平面波の基底関
数を用いて電子被占有の軌道を展開し，その波動関数をもとに一電子方程式を解
くことにより電子状態を求める．交換相関ポテンシャルはGGA(generalized gra-

dient approximation) を用いた．そして，擬ポテンシャルとして PAW(projector

augmented wave) を用いた．

2.3.3 VASP(Vienna Ab-initio Simulation Package)

VASP[6]は平面波・擬ポテンシャル法（ならびにPAW法）による第一原理バン
ド計算プログラムである．平面波基底の重ね合わせで波動関数を表現し，密度汎
関数理論に基づいて電子状態の計算を行う．平面波を使用する利点として，その
系の原子にかかる力の計算を正確かつ高速に行える点が挙げられる．このことか
ら，VASPは構造最適化や第一原理分子動力学計算のツールとして幅広く用いら
れている．また，擬ポテンシャ法により内殻電子をポテンシャルに置き換えて取
り扱うので，波動関数の表現に用いる平面波基底の数を大幅に減らし，計算量を
軽減する．内殻電子の取り扱いについては，擬ポテンシャル法の他に，全電子計
算PAW法を採用しており，擬ポテンシャル法と比べさほど計算量を増やすことな
く，精度を上げることができる．バルク構造，表面，界面など広範に渡る問題に
適用できる汎用的なソフトウェアである．
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2.3.4 PAW(Projector Augmented Wave)法

本論では，VASPを使用するに至り，擬ポテンシャル法としてPAW法を用いた．．
擬ポテンシャル法には，フルポテンシャル・PAWポテンシャル・(ウルトラソフト
型)擬ポテンシャルの 3つに分類される．PAWポテンシャルはBlochlが考案した
全電子計算の方法で，フルポテンシャルの精度と擬ポテンシャルの高速性の両者
を兼ね備えた方法で，それぞれの特徴を表 2.1に示す．

表 2.1: 擬ポテンシャル法とフルポテンシャル法の比較

フルポテンシャル ○精度が高い
○全元素対応
×計算時間がかかるため，小さな系のみ
×原子半径等，パラメータ設定に熟練が必要

PAW法 ○フルポテンシャルの精度を維持しながら計算時間を軽減
○全元素対応

(ウルトラソフト型) ○計算時間を軽減
×アルカリ金属，アルカリ土類，希土類に難

2.3.5 力の定数 [7]

力の定数の求め方は 1次元調和振動子 (図 2.3)を例にすると，力の式は次のよう
に示される．

　

F = −Cu (2.9)

ここで F は力，Cは力の定数，uは動かした距離をおらわす．このように，力の
値と動かした距離がわかれば力の定数 Cの値が求められる．3次元では基本的に
求め方は同じであるが，力の式は次のようなものとなる．

　

F = −
∑

l

Cl · ul (2.10)

力 F および動かした距離 ulはベクトル，力の定数 Clは 3× 3の行列となってい
る．また l は原子の番号をあらわす．この (2.10式)より，力の定数の値を求める．
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図 2.3: 1次元調和振動子

2.3.6 分散関係 [8][9]

まず例として 1次元の分散関係を求める (図 2.4)．ある時刻 tにおいて n番目の
原子の平衡位置からの変位を unとする．n番目の原子に働く力を考えると運動方
程式は次のようなものとなる．

　

M
∂2un

∂t2
= C(un+1 − un) − C(un − un−1) (2.11)

この式に次のような進行波の解

　

un = Aexp[i(ωt − kna)] (2.12)

を代入すると式 (2.11)は次のように変形できる．ただしAは振幅，aはバネの長
さをあわらす．

　

−Mω2un = −4Cun sin
(

1

2
ka

)
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...ω =

√
4C

M

∣∣∣∣sin
(

1

2
ka

)∣∣∣∣ (2.13)

式 (2.13)を波数 kについてプロットすると，図 2.5のようになる． 3次元の場合に

　

図 2.4: 1次元バネモデル

ついてもほぼ同様の計算を行う．原点での運動方程式は

　

m
∂2u0

∂t2
= −

∑

l

Cl · ul (2.14)

式 (2.14)に次に示す平面波の解を代入する．

　

ul(k) = Aexp[i(k · rl − ωt)] (2.15)

すると式 (2.14)は

　

mω2A =
∑

l

Cl · Aexp[ik · rl] (2.16)

さらにダイナミカルマトリックスを次式で定義する．

　

D(k) =
1

m

∑

l

Cl · exp(ik · rl) (2.17)
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図 2.5: 1次元の第一ブリルアンゾーン内の分散曲線

式 (2.17)を用いると式 (2.16)は次のようなものとなる．

　

ω2A = D(k) · A (2.18)

D(k)は 3× 3の行列，Aはベクトルとなっている．すなわち 3次元では固有値
問題となっていて，ダイナミカルマトリックスの固有値を求めることにより波数
kと周波数ω の分散関係が求められる．ただし，3次元分散曲線では横波と縦波が
存在するため，曲線は複数個存在する．

2.3.7 状態密度

フォノンの分散関係がわかったことにより，フォノンの状態密度が求められる．
フォノンの周波数が ωと ω+dω の間にある可能な kの数は

　

D(ω)dω =
(

L

2π

)3 ∫

shell
d3k (2.19)
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となる．Lは立方体の一辺の長さをあらわす．積分は，k空間において，フォノンの
周波数が一定の値 ωをとる表面と ω+dω との間にはさまれた殻状の体積にわたっ
て行う．ここで，k空間のある一定の周波数 ωの面上の面積素片を dSωとすると

　∫

shell
d3k =

∫
dSωdK⊥ (2.20)

であり，dK⊥はω一定の面とω+dωの面との垂直距離である．また，ωの勾配5kω

も ωが一定の面に垂直だから，

　

|5kω| dK⊥ = dω (2.21)

したがって，体積素片は

　

dSωdK⊥ = dSω
dω

|5kω|
= dSω

dω

vg

(2.22)

ただし vgはフォノンの郡速度である．V = L3を用いると，式 (2.19)は

　

D(ω) =
V

(2π)3

∫ dSω

vg

(2.23)

となりフォノンの状態密度が求められる．

2.3.8 自由エネルギー

自由エネルギーは次式によって与えられる．

　

F (a, T ) = Estat(a) +
∫ ωmax

0
D(ω)f(ω, T )dω (2.24)

ここでaは格子の長さをあらわし，Tは温度をあらわす．また，右辺第一項のEstat(a)

は静止エネルギー，すなわち振動していないときに格子が持つエネルギーをあらわ
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図 2.6: フォノン状態密度の描き方．

し，右辺第二項は振動の自由エネルギーをあらわす．また，右辺第二項の f(ω, T )

はフォノン一個あたりの自由エネルギーをあらわし，次式で定義される．

　

f(ω, T ) = kT ln
[
2sinh

(
hω

4πkT

)]
(2.25)

式 (2.24)を用いてある格子定数のもとでの各々の温度における自由エネルギーを
求める．ただし，kはボルツマン定数，hはプランク定数をあらわす．

2.3.9 格子定数

式 (2.24)の右辺第一項は格子の長さに依存し，格子の長さに対して単調に増加
する関数となる．また，フォノンの状態密度D(ω) が格子の長さに依存する．そ
のため，右辺第二項は温度を一定にすると，格子の長さに対して単調に減少する
関数となる．
よって式 (2.24)の右辺第一項と第二項を足し合わせることにより，極小値が得
られる．そして，自由エネルギーが極小値をとるときの格子の長さをその温度で
の計算上の格子定数とする．
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2.3.10 熱膨張

まず，線形熱膨張率は次式で定義される．

　

ε(T ) =
a(T ) − a0

a0

(2.26)

ここで a0は基準となる格子の長さをあらわす．
線形熱膨張係数は次式で定義される．

　

a(T ) =
1

a0

(
da(T )

dT

)
(2.27)
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第3章 計算結果

3.1 概要
準安定溶媒エピタキシー法の駆動力となっているのは SiCの代表的な多形であ

る 3C,4H,6H-SiCの安定性の差である．節 1.6.1より，準安定溶媒エピタキシー法
の実験では 4H-SiCのエピタキシャル成長が起こっている．これは 4Hが 3Cより
安定な相であることに起因している．節 1.4で示したとおり，種々の SiC作製法に
よって得られた多形の発生頻度によると，準安定溶媒エピタキシー法が行われる
1800℃では 3Cより 4Hの発生確率が高い．しかし，節 1.5で示したとおり，熱力
学的測定では cubicである βが安定相とされている．このように実験では異なった
データがでている．そこで 3C,4H,6H-SiCの有限温度における自由エネルギーを第
一原理計算で求めた．
まず，振動の自由エネルギーを求めるためには結晶の静止エネルギーを求めな
くてはならない．そのため，第一原理バンド計算プログラムであるVASPを使用
して 3C,4H,6H-SiCの静止エネルギーを求めて，エネルギー・体積曲線を求めた．
図 1.2の他の研究者と同等な結果が得られた．したがって，この研究での第一原理
計算の結果は他の第一原理計算と同じ程度の精度を持つと判断できた．
次に，phonon-DOS法を用いて一定体積の場合の振動の自由エネルギーを求め

た．熱膨張による体積変化を考慮する場合は，c/aを最安定値に固定，c/aを文献
の値に固定，c/aを固定しない順に計算した．

3.2 エネルギー ·体積曲線
エネルギーの体積依存性を求めた曲線，いわゆる E-V曲線は，第一原理計算の
基本ながら重要な情報を与えてくれる．x軸座標に体積をとり，y軸座標にエネル
ギーをとっている．y軸座標は下にいくほどエネルギーが低くなっている．無限遠
ではお互いが相互作用せず，エネルギー準位としてゼロにとる．そこから距離を
近づける (体積を小さくする)と，お互いが引き寄せ合う．さらに，近づけすぎる
と急激に反発が強くなる．この特徴的な振る舞いは，2原子間の結合を支配する二
つの重要な構成要素を示している．引力と斥力がちょうどつり合う位置で，2原子
は平衡を保つ．この曲線において，頂点にあたる位置が平衡状態であり，x座標が
各結晶における最安定時の体積となり，y座標が結合エネルギーとなる．図 3.1で
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図 3.1: 第一原理計算で求めた 3C,4H,6H-SiCのエネルギー・体積 (E-V)曲線．
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図 3.2: 図 3.1の極小値をくわしく示した曲線．
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は 3C 4H 6H SiCとも相安定性の結合エネルギーが同様であることが見てとれる．
しかし，極小値の所を細かくみた図 3.2では相安定性は 6H > 4H > 3Cとなって
おり，図 1.2の他の研究者と同等な結果が得られている．したがって，この研究で
の第一原理計算の結果は他の第一原理計算と同じ程度の精度を持つと判断できる．

3.3 一定体積の場合

3.3.1 フォノン分散曲線

3C-SiCは 2× 2× 2のスーパーセルであり 4H,6H-SiCは 3× 3× 1のスーパー
セルでフォノンの分散曲線を求めた．図 3.3，図 3.4，図 3.5で分枝の個数が異なる
のは単位格子あたりの原子の数が違うからであり，単位格子あたり n個の原子が
あるときには，3n個の分枝が存在することになる．しだがって，3C SiCは 6個，
4H SiCは 24個，6H SiCは 36個の分枝が存在する．

表 3.1: 3C SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

0 11.832 13.652 15.794 21.622 22.663 25.063

0.002 11.83 13.652 15.794 21.623 22.662 25.064

0.004 11.823 13.65 15.794 21.625 22.66 25.065

0.0061 11.811 13.648 15.794 21.629 22.656 25.069

0.0081 11.795 13.645 15.794 21.635 22.65 25.073

: : : : : : :

0.3549 0.406 0.406 0.607 23.061 23.061 23.069

0.3574 0.203 0.203 0.303 23.059 23.059 23.061

0.3599 -0.008 -0.008 -0.008 23.059 23.059 23.059

0.3627 0.238 0.238 0.345 23.058 23.058 23.064

0.3656 0.477 0.477 0.69 23.058 23.058 23.08

: : : : : : :

以下 397点続くが省略する．
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図 3.3: 3C SiCの分散曲線．

表 3.2: 4H SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5595 0.058 0.067 0.11 5.683 5.7 5.926

0.5604 -0.07 -0.01 0.033 5.689 5.706 5.921

0.5642 -0.372 0.246 0.671 5.702 5.708 5.929

0.568 0.027 0.497 1.12 5.702 5.755 5.94

0.5718 0.597 0.767 1.561 5.699 5.834 5.958

: : : : : : :

1.0583 0.619 0.848 1.679 5.762 5.855 5.988

1.0615 0.231 0.636 1.322 5.731 5.789 5.959

1.0648 -0.363 0.425 0.964 5.709 5.742 5.938

1.0681 -0.396 0.214 0.594 5.694 5.715 5.926

1.0714 -0.07 -0.01 0.033 5.689 5.706 5.921

33



図 3.4: 4H SiCの分散曲線．

表 3.3: 6H SiCのフォノン分散曲線の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5409 0.053 0.057 0.064 4.184 4.204 4.359

0.5415 -0.063 0.039 0.049 4.19 4.21 4.353

0.5453 -0.414 0.239 0.69 4.207 4.216 4.367

0.5491 -0.25 0.476 1.132 4.22 4.268 4.379

0.5528 0.531 0.728 1.56 4.235 4.36 4.4

: : : : : : :

1.0368 0.554 0.839 1.681 4.283 4.393 4.443

1.04 -0.092 0.63 1.331 4.244 4.313 4.405

1.0433 -0.418 0.421 0.978 4.216 4.255 4.377

1.0466 -0.421 0.214 0.61 4.197 4.221 4.36

1.0498 -0.063 0.039 0.049 4.19 4.21 4.353
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図 3.5: 6H SiCの分散曲線．
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3.3.2 フォノン状態密度

フォノンの分散関係から得られた状態密度 (図 3.6)は振動数が 0～20THz]の音響
モードでは 3C,4H,6H-SiC 共通して低い値で安定している．振動数が 20～30[THz

の光学モードでは 3C,4H,6H-SiC 共通して値が急激に上がったり，下がったりし
ている．なぜ，3C,4H,6H-SiCでは異なる形のフォノン分散曲線になっているのに
フォノン状態密度は似たような形になっているのか．それは，3C,4H,6H-SiCはユ
ニットセルでは原子数や原子配置が異なっているが，局所的には Si-Cの結合様式
は同様であるからである．

図 3.6: 3C 4H 6H SiCのフォノン状態密度．

3.3.3 自由エネルギー

Cv : vibrational heat capacity at constant volume.

E(T)-E(0) : the change in vibrational internal energy from 0 K.

E(0) is the zero point energy (ZPE).

S(T) : the vibrational entropy at temperature T.

-(A(T)-E(0)) : the change in the vibrational Helmholtz free energy from 0 K.

E(T) : the electronic plus vibrational energy of formation.

A(T) : the electronic plus vibrational Helmholtz free energy.
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表 3.4: 3C SiCの Phonon計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.1161 -30.1161

100 4.5382 0.1144 1.4893 0.0346 -30.0017 -30.1507

200 16.9247 1.1816 8.3904 0.4965 -28.9345 -30.6126

400 34.5887 6.5658 26.3376 3.9692 -23.5503 -34.0853

800 45.0984 23.0581 54.5058 20.5462 -7.0580 -50.6624

1600 48.6118 60.9838 87.2317 78.5860 30.8677 -108.7021

2000 49.0645 80.5288 98.1332 115.7364 50.4127 -145.8525

2400 49.3133 100.2087 107.1027 156.8364 70.0926 -186.9525

2800 49.4644 119.9664 114.7167 201.2382 89.8503 -231.3543

3000 49.5186 129.8649 118.1313 224.5268 99.7488 -254.6429

表 3.5: 4H SiCの Phonon計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.3941 -30.3941

100 4.4999 0.1140 1.4800 0.0340 -30.2802 -30.4282

200 16.7892 1.1710 8.3146 0.4919 -29.2231 -30.8861

400 34.5041 6.5322 26.1799 3.9397 -23.8619 -34.3338

800 45.0712 23.0051 54.3121 20.4443 -7.3891 -50.8385

1600 48.6046 60.9196 87.0275 78.3235 30.5254 -108.7176

2000 49.0599 80.4622 97.9277 115.3919 50.0681 -145.7861

2400 49.3102 100.1406 106.8965 156.4095 69.7465 -186.8036

2800 49.4622 119.8973 114.5100 200.7289 89.5032 -231.1230

3000 49.5166 129.7953 117.9245 223.9760 99.4012 -254.3701
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表 3.6: 6H SiCの Phonon計算結果の数値．
T Cv E(T)-E(0) S(T) -(A(T)-E(0)) E(T) A(T)

K J/K/mol kJ/mol J/K/mol kJ/mol kJ/mol kJ/mol

0 0.0000 0.0000 0.0000 0.0000 -30.0794 -30.0794

100 4.6351 0.1181 1.5333 0.0352 -29.9613 -30.1146

200 16.9741 1.1928 8.4885 0.5049 -28.8866 -30.5843

400 34.6062 6.5827 26.4567 3.9999 -23.4966 -34.0793

800 45.1043 23.0791 54.6325 20.6266 -7.0002 -50.7059

1600 48.6135 61.0074 87.3607 78.7689 30.9280 -108.8482

2000 49.0657 80.5529 98.2625 115.9710 50.4735 -146.0503

2400 49.3142 100.2332 107.2323 157.1226 70.1539 -187.2020

2800 49.4652 119.9913 114.8463 201.5763 89.9119 -231.6557

3000 49.5192 129.8898 118.2610 224.8909 99.8105 -254.9703

図 3.7: SiCの振動の自由エネルギーから求めた温度依存性．
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図 3.8: 4Hを基準にとった，SiCの振動の自由エネルギーから求めた温度依存性．
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図 3.7は 3C,4H,6H-SiCの温度に対する自由エネルギーを出したものであるが，
温度に対してエネルギーの差がないことが分かる．このスケールで見ると，図 3.8

は 4H-SiCを基準にして温度に対する自由エネルギーを出したものである．こちら
は，温度に対してエネルギーの差があることが分かる，低温では 3C,4H-SiC，高
温では 6H-SiCが最も安定な構造でおり，中間温度の自由エネルギーは　 3C > 4H

> 6H　となっており，これは，温度に対する結晶多形の発生確率の結果と一致し
ており，結晶成長させるときの実験結果とも一致している．

3.4 体積変化を考慮した場合 (c/aを最安定値に固定し
た場合)

3.3節では体積を考慮しない場合の計算結果を示している．しかし，固体の体積
が温度の上昇につれて増加する熱膨張を考慮する．これは熱によって分子運動が
はげしくなり，分子間距離が大きくなるためである．3.3節での体積を 1.0と基準
にし，今回の計算では 3C，4H，6H-SiC ともに 0.990, 09925, 0.995, 0.9975, 1.0,

1.0025, 1.005, 1.0075, 1.01, 1.0125, 1.015, 1.0175, 1.02, 1.0225 1.025, 1.0275, 1.03

の計 17点の体積で計算しそれぞれの温度に対して極小のエネルギーを出している．
その場合の熱膨張率は c/aを最安定値に固定している．

3.4.1 フォノン分散曲線

3C-SiCは 2× 2× 2のスーパーセルであり 4H,6H-SiCは 3× 3× 1のスーパーセ
ルでフォノンの分散曲線を求めた．表 3.7，表 3.8での 3C SiCのフォノン分散曲線
の Γ点周辺の数値は虚の値がほとんどない．しかし，表 3.9，表 3.10，表 3.11，表
3.12での 4H,6H-SiCのフォノン分散曲線の Γ点周辺の数値は体積の倍率を増やす
とともに虚の値が増大している．虚の振動が出る理由は 2つある．1つは計算精度
が不十分である．もう一つは構造が不安定である．計算精度が原因の場合は，精度
を上げていくことで分散曲線が改善されていくかを確認する必要がある．Phonon

の計算を行うときには，計算に用いる構造モデルが重要である．Phonon計算を行
う前に構造最適化を行う．このときに収束条件を厳しく設定することで計算精度
を上げることができる．しかし，今回の場合は計算精度が原因であると考えるよ
り構造が不安定であるのが原因と考えられる．なぜならば，Phonon計算を行う前
の構造が熱膨張を考慮し体積変化させているため基底状態において最適ではない
からである．
安定でない構造のとき虚の振動数がでる理由は単純な 2次元のポテンシャル曲
線で考えると，下に凸 (図 3.9)な場合，その曲線の底がエネルギー最安定な状態に
対応している．この点の振動数を見積もるとき，例えば 2次曲線近似を導入する
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と，エネルギーは次式で定義される．

　

E = k(r − r0)
2 (3.1)

振動数は次式で定義される．

　

ν =
1

2π

√
k

M
(3.2)

kバネ定数であり，kの正負によって振動数 νは正の値あるいは虚の値になる．下
に凸の曲線の場合は kは正であり，振動数 ν も正になる．もし曲線が上に凸 (図
3.9)であるとすると，kは負になり，振動数 νも虚になる．ポテンシャル曲線が上
に凸であるということは，この極点はエネルギーが高い状態にあり，より下がる
ことができる．つまり不安定であることがいえる．

図 3.9: (a)下に凸の曲線．(b)上に凸の曲線
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表 3.7: 3C SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.3514 0.406 0.406 0.591 22.299 22.299 22.307

0.3539 0.208 0.208 0.299 22.297 22.297 22.299

0.3563 0.049 0.049 0.049 22.296 22.296 22.296

0.3591 0.24 0.24 0.342 22.296 22.296 22.302

0.362 0.471 0.471 0.678 22.296 22.296 22.318

: : : : : : :

以下 397点続くが省略する．

表 3.8: 3C SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.348 0.393 0.393 0.562 21.648 21.648 21.656

0.3504 0.191 0.191 0.277 21.646 21.646 21.648

0.3528 -0.056 -0.056 -0.056 21.646 21.646 21.646

0.3556 0.223 0.223 0.321 21.646 21.646 21.651

0.3584 0.456 0.456 0.649 21.645 21.645 21.645

: : : : : : :

以下 397点続くが省略する．
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図 3.10: 3C SiCの分散曲線．

表 3.9: 4H SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.554 0.051 0.056 0.112 5.705 5.718 5.913

0.5549 -0.05 -0.029 -0.018 5.711 5.724 5.907

0.5586 -0.395 0.242 0.673 5.722 5.728 5.922

0.5624 -0.204 0.492 1.111 5.72 5.772 5.947

0.5661 0.542 0.756 1.536 5.717 5.845 5.966

: : : : : : :

1.0478 0.548 0.847 1.654 5.781 5.863 5.978

1.051 -0.088 0.635 1.31 5.752 5.801 5.949

1.0543 -0.412 0.424 0.963 5.73 5.758 5.927

1.0575 -0.416 0.211 0.6 5.717 5.732 5.912

1.0608 -0.05 -0.029 -0.018 5.711 5.724 5.907
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表 3.10: 4H SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5486 0.056 0.06 0.065 5.671 5.695 5.899

0.5494 -0.104 -0.018 0.028 5.676 5.701 5.893

0.5531 -0.392 0.247 0.657 5.69 5.702 5.897

0.5568 -0.204 0.499 1.087 5.699 5.735 5.908

0.5606 0.536 0.766 1.504 5.7 5.806 5.926

: : : : : : :

1.0375 0.527 0.845 1.62 5.747 5.833 5.971

1.0407 -0.145 0.634 1.285 5.718 5.774 5.943

1.0439 -0.419 0.423 0.946 5.696 5.733 5.92

1.0472 -0.418 0.213 0.588 5.681 5.709 5.901

1.0504 -0.104 -0.018 0.028 5.676 5.701 5.893

図 3.11: 4H SiCの分散曲線．
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表 3.11: 6H SiCのフォノン分散曲線 (1.01倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5356 0.051 0.052 0.088 4.175 4.208 4.321

0.5362 0.03 0.032 0.04 4.182 4.216 4.314

0.5399 -0.401 0.239 0.676 4.199 4.22 4.331

0.5436 -0.235 0.479 1.108 4.224 4.258 4.359

0.5473 0.527 0.734 1.525 4.24 4.345 4.383

: : : : : : :

1.0265 0.543 0.835 1.643 4.276 4.384 4.405

1.0297 -0.105 0.627 1.303 4.237 4.31 4.367

1.033 -0.413 0.419 0.96 4.208 4.257 4.339

1.0362 -0.413 0.211 0.601 4.189 4.226 4.32

1.0394 0.03 0.032 0.04 4.182 4.216 4.314

表 3.12: 6H SiCのフォノン分散曲線 (1.02倍)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5303 0.055 0.056 0.059 4.011 4.1 4.268

0.5309 -0.047 0.038 0.04 4.015 4.106 4.262

0.5346 -0.393 0.241 0.66 4.02 4.123 4.27

0.5383 -0.226 0.481 1.082 4.035 4.175 4.283

0.542 0.519 0.739 1.488 4.059 4.261 4.305

: : : : : : :

1.0164 0.523 0.83 1.603 4.152 4.237 4.348

1.0196 -0.148 0.623 1.274 4.099 4.174 4.311

1.0228 -0.416 0.417 0.94 4.055 4.135 4.284

1.026 -0.412 0.211 0.589 4.026 4.113 4.268

1.0292 -0.047 0.038 0.04 4.015 4.106 4.262
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図 3.12: 6H SiCの分散曲線．
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3.4.2 自由エネルギーのフィッティング

3C,4H,6H-SiCともに温度 Tを 0,800,1200,1600,2000,2400,3000と変化させ，自
由エネルギーを求めた (図 3.13,図 3.14 図 3.15)．極小値を取るときの rの値が平
衡原子間距離 r0になる．それぞれの図より平衡原子間距離は増加していることが
分かる．

図 3.13: 3C SiCの熱膨張の自由エネルギー．
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図 3.14: 4H SiCの熱膨張の自由エネルギー．

図 3.15: 6H SiCの熱膨張の自由エネルギー．
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3.4.3 自由エネルギー

図 3.16は 3C,4H,6H-SiCの温度に対する自由エネルギーを出したものであるが，
温度に対してエネルギーの差がないことが分かる．しかし，図 3.17は 4H-SiCを基
準にして温度に対する自由エネルギーを出したものである．こちらは，温度に対
してエネルギーの差があることが分かる，低温では 3C,4H-SiC，高温では 6H-SiC

が最も安定な構造である，しかし，中間温度の自由エネルギーは 4H > 6H > 3C

となっており，これは，温度に対する結晶多形の発生確率の結果と一致してなく，
結晶成長させるときの実験結果とも一致してない．理由は 4H,6H-SiCの六方晶の
場合 a,c軸を独立して考えなければならないからである．

図 3.16: SiCの振動の自由エネルギーから求めた温度依存性．
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図 3.17: 4Hを基準にとった，SiCの振動の自由エネルギーから求めた温度依存性．
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3.5 体積変化を考慮した場合 (c/aを文献値に固定した
場合)

O. Madelung[10]らのデータを参考に 4H,6H-SiCの熱膨張係数を表 3.13のよう
にする．3C-SiCは立方晶のため a,cの長さが同様なため a,cの熱膨張係数も同じに
なる．

表 3.13: 空間群 P63mcの格子定数と熱膨張係数 (O. Madelung. ed.[10]参照)．
Crystalline properties GaN AlN InN α-Al2O3 6H-SiC

Lattice Parameter(Å) a 3.186 3.1114 3.5446 4.758 3.081

c 5.178 4.9792 5.7034 12.991 15.092

Thermal expansion a 5.59 4.2 5.7 7.5 4.2

coefficient(× 10−6/K) c 3.17 5.3 3,7 8.5 4.68

今回の計算では 3C-SiCは前の節での c/aを 1:1に固定した計算結果を使用し，
4H,6H-SiCは c,aの熱膨張率が異なるので表??を参考に例えば 1000Kのときの熱
膨張率は次のように仮定する．

αa = 4.2× 10−6× 1000 (3.3)

αc = 4.68× 10−6× 1000 (3.4)

この計算では 0K, 100K, 200K, 400K, 600K, 800K, 1000K, 1200K, 1400K, 1600K,

1800K, 2000K, 2200K, 2400K, 2600K, 2800K, 3000K, 3200K, 3400K, 3600K, 3800K,

4000K, 4200k, 4400K, 4600K, 4800K, 5000K, 5200K, 5400K, 5600K, 5800Kの計
25点で体積で計算しそれぞれの温度に対して極小のエネルギーを出している．

3.5.1 フォノン分散曲線

3C-SiCは 2× 2× 2のスーパーセルであり，3.4節と同様な計算である．4H,6H-

SiCは 3× 3× 1のスーパーセルでフォノンの分散曲線を求めた．表 3.14，表 3.15，
表 3.16，表 3.17での 4H,6H-SiCのフォノン分散曲線の Γ点周辺の数値は c/aを 1:1

に固定した場合にくらべて虚の数値が減少していが，虚の振動数が出ている．こ
れは 4H,6H-SiCの構造が熱膨張を考慮し体積変化させているため安定でないから
である．
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表 3.14: 4H SiCのフォノン分散曲線 (2000K)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5548 0.071 0.071 0.129 5.671 5.694 5.892

0.5557 -0.008 0.039 0.041 5.677 5.7 5.886

0.5594 -0.368 0.248 0.666 5.691 5.701 5.9

0.5632 0.024 0.496 1.106 5.698 5.741 5.916

0.567 0.6 0.762 1.535 5.698 5.818 5.935

: : : : : : :

1.0494 0.614 0.844 1.648 5.75 5.844 5.955

1.0526 0.227 0.634 1.3 5.72 5.78 5.926

1.0559 -0.359 0.424 0.951 5.697 5.735 5.905

1.0592 -0.389 0.215 0.589 5.682 5.708 5.891

1.0624 -0.008 0.039 0.041 5.677 5.7 5.886

表 3.15: 4H SiCのフォノン分散曲線 (4000K)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5502 0.057 0.061 0.12 5.661 5.673 5.865

0.5511 -0.035 -0.01 0.018 5.667 5.68 5.859

0.5548 -0.364 0.246 0.655 5.678 5.684 5.872

0.5585 0.051 0.498 1.087 5.68 5.729 5.886

0.5622 0.598 0.765 1.509 5.683 5.803 5.905

: : : : : : :

1.0407 0.605 0.841 1.615 5.737 5.821 5.926

1.0439 0.217 0.631 1.275 5.708 5.758 5.898

1.0471 -0.36 0.421 0.934 5.686 5.714 5.877

1.0504 -0.387 0.211 0.579 5.673 5.688 5.864

1.0536 -0.035 -0.01 0.018 5.667 5.68 5.859
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図 3.18: 4H SiCの分散曲線．

表 3.16: 6H SiCのフォノン分散曲線 (2000K)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5364 0.028 0.037 0.041 4.217 4.228 4.36

0.537 -0.075 -0.03 -0.006 4.224 4.236 4.352

0.5407 -0.375 0.249 0.661 4.237 4.245 4.362

0.5444 -0.094 0.502 1.098 4.248 4.3 4.376

0.5482 0.591 0.766 1.524 4.266 4.386 4.406

: : : : : : :

1.0281 0.6 0.842 1.639 4.314 4.411 4.444

1.0313 0.201 0.632 1.293 4.276 4.337 4.403

1.0346 -0.369 0.421 0.946 4.248 4.28 4.375

1.0378 -0.395 0.209 0.584 4.231 4.246 4.359

1.0411 -0.075 -0.03 -0.006 4.224 4.236 4.352
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表 3.17: 6H SiCのフォノン分散曲線 (4000K)の Γ点周辺の数値．
波数空間 振動数 1 振動数 2 振動数 3 振動数 4 振動数 5 振動数 6

: : : : : : :

0.5319 0.042 0.045 0.069 4.189 4.19 4.325

0.5325 -0.042 0.009 0.019 4.196 4.198 4.317

0.5362 -0.369 0.251 0.653 4.201 4.215 4.322

0.5399 -0.092 0.505 1.081 4.212 4.27 4.337

0.5436 0.587 0.768 1.498 4.232 4.356 4.365

: : : : : : :

1.0196 0.591 0.84 1.606 4.283 4.376 4.404

1.0228 0.194 0.631 1.269 4.245 4.299 4.367

1.026 -0.365 0.421 0.93 4.218 4.243 4.341

1.0292 -0.389 0.211 0.577 4.202 4.209 4.325

1.0324 -0.042 0.009 0.019 4.196 4.198 4.317

図 3.19: 6H SiCの分散曲線．
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3.5.2 自由エネルギー

図 3.20は 3C,4H,6H-SiCの温度に対する自由エネルギーを出したものであるが，
温度に対してエネルギーの差がないことが分かる．しかし，図 3.21は 4H-SiCを基
準にして温度に対する自由エネルギーを出したものである．こちらは，温度に対し
てエネルギーの差があることが分かる，低温では 4H-SiC，高温では 6H-SiCが最も
安定な構造である，しかし，中間温度の自由エネルギーは 3C> 4H > 6Hとなって
おり，これは，温度に対する結晶多形の発生確率の結果と一致しており，結晶成長
させるときの実験結果とも一致している．理由として考えられるのは，4H,6H-SiC

の熱膨張率が c/aで 1:1 よりも c/aを 4.68:4.2にしたことによって精確に熱膨張を
再現したと考えられる．

図 3.20: SiCの振動の自由エネルギーから求めた温度依存性．
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図 3.21: 4Hを基準にとった，SiCの振動の自由エネルギーから求めた温度依存性．
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3.6 体積変化を考慮した場合 (c/aを固定しない場合)

3.5節より熱膨張率は温度によって変化することが熱膨張の原理なので，この節で
は c/aを固定しないで計算する．手法は 3.3節の体積を 1.0と基準にし，4H,6H-SiC

は a軸に 1.0～1.025まで 0.005ずつ増やす．c軸も 1.0～1.025まで 0.005ずつ増や
して計 36点体積で計算しそれぞれの温度に対して極小のエネルギーを出している．
3C-SiCは立方晶ため c/aが 1:1のため 3.4節のエネルギーを使用する．

3.6.1 熱膨張の比較

図 3.22 の 3C SiCの実験値はZ. Li and R. C. Bradt[11]の論文のデータを使用し
ている．式 (2.26)より線形熱膨張率 ε[％]を求めている．基準となる温度は 0[℃]と
する．図 3.22での計算値は 700[℃]付近では 0.027％程度実験値より縮んでいる．
1000[℃]付近でも高々0.030％程度の差しかない．

図 3.22: 3C SiCの線形熱膨張率の比較．

図 3.23 の 4H SiCの実験値は Z. Li and R. C. Bradt[12]の論文のデータを使用
している．基準となる温度は 0[℃]とする．図 3.23での計算値は 700[℃]付近では
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a軸は 0.055％，c軸は 0.065％程度実験値より縮んでいる．1000[℃]付近でも高々
a軸は 0.072％，c軸は 0.092％程度の差しかない．

図 3.23: 4H SiCの線形熱膨張率の比較．

図 3.24 の 6H SiCの実験値は Z. Li and R. C. Bradt[13]の論文のデータを使用
している．基準となる温度は 0[℃]とする．図 3.24での計算値は 700[℃]付近では
a軸は 0.055％，c軸は 0.072％程度実験値より縮んでいる．1000[℃]付近でも高々
a軸は 0.077％，c軸は 0.10％程度の差しかない．
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図 3.24: 6H SiCの線形熱膨張率の比較．
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3.6.2 自由エネルギーのフィッティング

自由エネルギーのフィッテングは 3C SiCは立方晶ため c/aが 1:1のため 3.4節の
エネルギーを使用する．4H,6H-SiCは各温度において a軸に 1.0～1.025まで 0.005

ずつ増やす．c軸も 1.0～1.025まで 0.005ずつ増やして計 36点の体積で計算し極
小のエネルギーを出している．
図 3.25は 4H SiCの 1000Kの時の a軸，c軸を膨張させたときの振動の自由エ

ネルギーである．Efixは膨張させない時の自由エネルギーである．Eminは各温度
の時の振動の自由エネルギーの極小値である．この自由エネルギーの極小値を c/a

を固定しない場合の自由エネルギーとする．図 3.25では膨張させない時のエネル
ギーと振動の自由エネルギーの極小値では 0.9204160[kJ/mol]低くなっている．

図 3.25: 4H SiCの 1000K時の c/aを変化させた振動の自由エネルギー．

図 3.26は 4H-SiCの 2000Kの時の a軸，c軸を膨張させた振動の自由エネルギー
である．Efixは膨張させない時の自由エネルギーである．Eminは 2000Kの時の振
動の自由エネルギーの極小値である．図 3.26では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 2.436058[kJ/mol]低くなっている．
図 3.27は 6H-SiCの 1000Kの時の a軸，c軸を膨張させた振動の自由エネルギー

である．Efixは膨張させない時の自由エネルギーである．Eminは 1000Kの時の振
動の自由エネルギーの極小値である．図 3.27では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 0.992297[kJ/mol]低くなっている．
図 3.28は 6H-SiCの 2000Kの時の a軸，c軸を膨張させた振動の自由エネルギー

である．Efixは膨張させない時の自由エネルギーである．Eminは 2000Kの時の振
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図 3.26: 4H SiC2000K時の c/aを変化させた振動の自由エネルギー．

図 3.27: 6H SiC1000K時の c/aを変化させた振動の自由エネルギー．
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動の自由エネルギーの極小値である．図 3.28では膨張させない時のエネルギーと
振動の自由エネルギーの極小値では 2.348668[kJ/mol]低くなっている．

図 3.28: 6H SiC2000K時の c/aを変化させた振動の自由エネルギー．
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3.6.3 自由エネルギー

図 3.29 は 3C 4H 6H-SiCの温度に対する自由エネルギーを出したものであるが，
温度に対してエネルギーの差がないことが分かる．しかし，図 3.30は 4H-SiCを基
準にして温度に対する自由エネルギーを出したものである．こちらは，温度に対
してエネルギーの差があることが分かる，低温では 4H-SiC，高温では 6H-SiCが
最も安定な構造でおり，中間温度の自由エネルギーは　 3C > 4H > 6H　となっ
ており，これは，温度に対する結晶多形の発生確率の結果と一致しており，結晶
成長させるときの実験結果とも一致している．

図 3.29: SiCの振動の自由エネルギーから求めた温度依存性．
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図 3.30: 4Hを基準にとった，SiCの振動の自由エネルギーから求めた温度依存性．
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第4章 まとめ

本研究では，振動の自由エネルギーの求め方は擬調和振動子近似である phonon-

DOS法を用いて計算した．またそれを 3C, 4H, 6H-SiCに適用し計算を行った．そ
の結果，図 4.1ような一定体積及び体積変化させた場合の自由エネルギーの温度依
存性が得られた．

• 低温では 4Hが最安定であるという新たな知見を得た．

• 一定体積では結晶多形の安定性は中間温度域で 3C, 4H, 6Hの順に大きくなっ
ている．

• 熱膨張による体積変化を考慮すると結晶多形の安定性が中間温度域から高温
度域にかけての広範囲で 3C, 4H, 6Hの順に大きくなっている．

図 4.1: 4Hを基準にとったSiCの振動の自由エネルギーから求めた温度依存性．(a)

一定体積の場合 (b)体積変化をした場合
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付 録A MedeAによるPHONON

の使用法

A.1 手順
1. 　MedeAを用いてセルを作る．

2. 　第一原理計算ソフトVASPを用いて原子にかかる力を求める．

3. 　かかった力のデータをPHONONに入力しフォノン分散関係，状態密度を計
算する．

このような手順によりフォノン分散曲線，状態密度を求める．具体的には 3C 4H

6H SiCの格子のエネルギーが最低となるときの計算について述べる．

A.2 セルの作成

A.2.1 モデルウィンドウを開く

Fileでは新しいファイル作成したり，すでにあるファイルを読み込んだりするこ
とができる．ここでは，新しいファイルの作成する．MedeAのメインメニューか
ら「File > New」を選択する．そしたら，周期境界を示すボックスのみが表示さ
れた「Untitled」の名前がついたウィンドウが表示される．

A.2.2 対称性の設定

1. 　まず，対称性の情報を入力する．

2. 　MedeAのメインメニューから「Edit > Edit structure... 」を選択する．ま
たは，モデルウィンドウ上でマウス右クリックし，「Edit Symmetry... 」を選
択する．

3. 　「Strucute Editor」が表示される．現在の対称性はP1となっている．「Space-

group:」の右にある
...
のボタンをクリックする．3C SiCの対称性はF-43m

4H 6H-SiCの対称性は P63mc　なので，「Primitive 」のリストの中から選択
して OK のボタンをクリックする．
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A.2.3 格子定数の設定

1. 　続いて，格子定数を変更する．デフォルトでは，新しい格子の定数は a=b=c=10

Å, α=β=γ=90°になっている．

2. 　MedaAのメインメニューから「Edit > Edit strucute」を選択し，「Structure

Editor」を開いたら，「Cell」タブを選択する．または，モデルウィンドウ上
では右クリックし，「Edit Cell...」を選択する．

3. 　 3C SiCは対称性が F-43mと規定されているため，a軸の長さのみ変更可能
になっている．3C SiCの格子定数はおよそ 4.36Åなので，A:の右のボック
スに 4.36と入力する．

表 A.1: 3C SiCの格子定数の例．
A B C α β γ

4.36 4.36 4.36 90 90 90

4. 　 4H 6H SiCは対称性がP63mcと規定されているため，a,c軸の長さのみ変更
可能になっている．4H SiCの a,c軸の格子定数はおよそ 3.08Å，10.05Åな
ので，A:の右のボックスに 3.08 ，C:の右のボックスに 10.05と入力する．

5. 　 6H SiCの a,c軸の格子定数はおよそ 3.08Å，15.12Åなので，A:の右のボッ
クスに 3.08 ，C:の右のボックスに 15.12と入力する．

表 A.2: 4H SiCの格子定数の例．
A B C α β γ

3.08 3.08 10.05 90 90 120

表 A.3: 6H SiCの格子定数の例．
A B C α β γ

3.08 3.08 15.12 90 90 120

6. 　画面上の周期境界を表す黒い線上にマウスカーソルを持っていくと，MedeA

ウィンドウの下に以下に表示されて，格子定数がわかる．

4H SiCの場合

Cell edgers: 3.0800 3.0800 10.0500 Cell angles: 90.00 90.00 120.00
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A.2.4 原子の入力

1. 　MedeAのメニューから 「Edit ¿ Edit structure... 」を選択し，「Structure

Editor 」を開いたら，「Add Atom」タブを選択する．または，マウス右ク
リックから「Add Atom..」を選択し，Structure Editor を開く．

2. 　まず，C原子を挿入する．Element 部分にはデフォルトでCが入っているの
で，そのまま SiCの Cを挿入していく．Si原子はキーボード入力で Siと変
更するか，その右側にあるアイコンをクリックして，周期律表を開き Siを選
択する．

表 A.4: 3C SiCの原子位置の例．
Name X Y Z

Si 0 0 0

C 0.25 0.25 0.25

表 A.5: 4H SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.25

C 0 0 0.17

C2 0.33333 0.66667 0.43750

表 A.6: 6H SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.66667

Si3 0.33333 0.66667 0.33333

C 0 0 0.125

C2 0.33333 0.66667 0.45833

C3 0.33333 0.66667 0.79167
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A.3 VASPの計算

A.3.1 計算設定

1. 　SiCの構造の最適化を計算する．MedeAメインメニューから「Tools > VASP.4.6」
を選択する．しばらくするとメインメニューにVASP.4.6が追加されるので，
「VASP.4.6 > RUN 」を選択する．

2. 　Calculationタブで以下の設定を行う．

・Type of calculationを Single Pointから Structure Optimizationに変更する．

・Structure Optimization Parameters の 3 つのチェックボックス全てをチェッ
クする．

・Tile は 4H-SiCなら 4H-SiCなどと入力するとよい．

・設定が終わったらRunボタンをクリックする．

A.3.2 計算実行

1. 　キューとプライオリティの指定を行う．

2. 　キューは takeda3と remoteがありお互い 4つの Jobを実行することができ，
それ以上の Jobを実行すると待ち状態 (pending)になる．

3. 　プライオリティは優先度のことであり，数を多くすると優先度が上がり，小
さくすると優先度が下がる．デフォルトでは 5になっている．

4. 　設定が終わったらRunボタンをクリックする．

A.3.3 計算結果

1. 　MedeAメインメニューの「Job Control > View and Job Control 」を選択
する．しばらくすると，ウェブブラウザが起動し，ジョブ制御画面が現れる．

2. 　黒いバーの中あるいはパイパーリンクされている Jobs をクリックすると，
ジョブー覧表が表示される．

3. 　ジョブの番号が割り当てられている．Statusの部分には現在のジョブの状態
が分かる．Status部分には以下の状態が存在する．

・running 計算が実行されている状態．
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・pending 計算がキューの中に投入されたが待ちになっている状態．

・finished 既に計算が終了している状態．

・error 計算に何らかの不具合が生じ，エラーとなってしまった状態．

・suspended ジョブサーバ (ジョブを管理するプログラム)に不具合が生じ，

計算が止められてしまった状態．

4. 　 Statusが finishedになった番号をクリックする．

5. 　Available Output Filesの一番の上のファイル Job.outをクリックする．これ
のファイルが計算のサマリになる．

6. 　 Job.outファイルの中には計算条件，計算結果 ( 構造，エネルギー，力，圧
力，計算時間 )に関する情報が収められている．構造最適化計算を行った場
合は計算前後の構造についての情報が入っている．構造最適化の結果，元の
格子からわずかに格子が収縮した状態で安定構造が求まっている．

A.4 Phononの計算
1. 　構造最適化計算の結果得られた安定構造はデータベースに収められており，

モデルウィンドウで開くことができる．MedeAのメインメニューから「File

> Open 」を選択し Previous Dalculationを選択する．

2. 　これまでの計算に使用した構造の一覧が表示されるので「minimized: 4-SiC」
などの minimizedどついている項目を選択し,[insert >> ] ボタンをクリック
すると，「Available」から「Curennt」覧に移動する．OKボタンをクリック
すると，結晶が表示される．

3. 　MedeAメインメニューから「Tools > Phonon」を選択する．しばらくする
とメインメニューに Phononが追加されるので，「Phonon > RUN 」を選択
する．

4. 　Phonon Simulationでは特に設定を変えない．Runポタンをクリックし計算
を開始させる．
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